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1 WebARSDK 使用手册

1.1 开发概述

WebARSDK 简介

WebARSDK是一款轻量化JS-SDK，支持租户通过SDK快速集成和使用KooMap AR地图
运行服务，开放能力的内存增加不大于3MB，运行时不依赖于Native App，可通过主
流Web浏览器平台、主流终端设备的App内嵌WebView，实现WebAR体验。

WebARSDK提供的API，可以将用户、空间及数字内容连接在一起 ，达到厘米级的定
位能力和1度以内的定姿能力，实现随时随地高精度的空间计算。在AR地图覆盖区
域，用户可进行3D实景步行导引，无需担心GPS信号弱的环境。

工作原理

WebARSDK通过设备传入的图像及传感器数据，调用视觉定位（VPS）和导航服务，
以及SLAM（同步定位与地图构建）算法，为您的应用提供环境感知与交互感知能力，
再经应用渲染给用户呈现虚实融合体验。

图 1-1 WebARSDK 工作原理

1.2 总体开发思路
使用WebARSDK开发移动端应用的工作流程如图1-2所示。

云地图服务
开发指南 1 WebARSDK 使用手册

文档版本 01 (2024-10-22) 版权所有 © 华为云计算技术有限公司 1



图 1-2 工作流程

1. 准备工作。

下载WebARSDK、收集AK/SK信息、开通关联服务。

2. 创建H5移动端工程。

使用原生或者流行框架（如Vue、React）创建H5移动端工程。

3. 引入WebARSDK文件。

下载、解压WebARSDK包，并将下载WebARSDK包放入工程目录，通过外部引入
脚本的方式引入WebARSDK文件。

4. 验证租户身份信息。

通过hwar.setAKSK方法将AK/SK传入SDK，验证租户身份信息。

5. 开启AR会话。

获取图像及传感器数据，初始化SLAM，准备相关环境。

6. 实现AR导航和渲染3D内容。

依靠视觉定位，获取当前设备位置，以及请求导航路径，实现空间位置追踪导
航；开发者基于SDK输出的图像数据、相机矩阵、路径信息，实现3D数字内容渲
染。
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1.3 准备工作

开发技能要求
● 具备TypeScript/JavaScript开发基础。

● 熟悉Web移动端开发。

● 熟悉Three.js、LayaAir等渲染库，可实现基于WebGL的3D渲染。

下载 SDK
请下载WebARSDK软件包和软件包的完整性校验文件，并解压软件包、核对文件目
录。

图 1-3 SDK 包目录结构

收集信息

表 1-1 收集信息

信息项 说明

AK/SK 访问密钥。包含访问密钥ID（Access Key ID，
AK）和秘密访问密钥（Secret Access Key，SK）
两部分，是您在华为云的长期身份凭证。华为云通
过AK识别访问用户的身份，通过SK对请求数据进
行签名验证，用于确保请求的机密性、完整性和请
求者身份的正确性。

获取方法请参见访问密钥。

 

开通关联服务

开通AR地图运行服务、AR地图数据构建服务、AR地图数据采集服务（可选）。
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说明

AR地图运行服务可在KooMap管理控制台开通。

AR地图数据采集服务、AR地图数据构建服务请咨询华为云专业服务团队购买并开通。

环境要求

● 已安装配置NodeJS环境。

● 已安装代码编辑器，如Visual Studio Code。

● 已安装Web服务器，如http-server、VSCode插件live-server、Tomcat等。

● Windows系统电脑已安装Chrome浏览器或基于Chromium内核的浏览器（例如
Edge）；Mac系统电脑已安装Safari浏览器。

● 移动设备已配置后置摄像头、陀螺仪、加速度传感器、GPS芯片等器件。

● 移动设备已安装支持WebRTC浏览器，如Chrome、Safari、华为浏览器等。

1.4 快速开始
以工程Project为例，通过引入SDK脚本、传入AK/SK、调用API，验证工程中SDK是否
引入正常，为后续功能开发做准备。

操作步骤

步骤1 创建工程（Project），并将WebARSDK包解压后放入工程目录。
Project
├── index.html
├── src
│   ├── index.js
├── hwar 
│   ├── slam 
│   │   └── LOG-iMedia_XREngine_Cyberverse_3.1.0.js 
│   │   └── LOG-iMedia_XREngine_Cyberverse_3.1.0.wasm 
│   │   └── slamcommon.js
│   ├── hwar.js

步骤2 通过外部脚本引入WebARSDK的JS文件。
<script src="hwar/slam/LOG-iMedia_XREngine_Cyberverse_3.1.0.js"></script>
<script src="hwar/slam/slamcommon.js"></script>
<script src="hwar/hwar.js"></script>

步骤3 传入AK/SK。
// 认证用的AK、SK硬编码到代码中或明文存储都有很大的安全风险，建议在代码中配置加密后的AK/SK，解密后
传入hwar.setAKSK方法中。
hwar.setAKSK({ 
    AK:"解密后的变量", 
    SK:"解密后的变量"
});

步骤4 调用API（以“hwar.searchArea”）验证引入效果。
// 根据GPS判断地图服务区域
hwar.searchArea({
    "location": { "lon": xxx, "lat": xxx },
    "radius": 50
}).then((res) => {
    console.log("根据GPS获取局点：" + JSON.stringify(res));
});
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步骤5 查看控制台输出，如果能够打印区域信息，则说明引入成功。

----结束

后续步骤

创建H5工程后，您可以继续开发AR功能。

● 开启AR会话，具体请参见开启AR会话。

● 实现AR导航，具体请参见实现AR导航。

1.5 开启 AR 会话

1.5.1 概述

您可开启AR会话获取设备的图像、GPS坐标及传感器数据，启动SLAM从而进行视觉定
位。

说明

传感器包括陀螺仪、加速度计、磁力计。

1.5.2 开发指导

开发流程

图 1-4 开启 AR 会话开发流程
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开发过程

步骤1 获取Token。

成功获取Token后才能进行定位请求。
// 向服务器请求签名
hwar.getToken().then((res) => { 
    // 获取成功
}).catch((err) => {
    // 获取失败
});

步骤2 设置并检查AR会话开启前的相关配置。

配置操作包括创建会话、设置位置、检测陀螺仪。

说明

● 创建会话：用于启动相机及SLAM。

● 设置位置：用于设置已知地图服务区域的GPS坐标，提高后续视觉定位的精度。

● 检测陀螺仪：用于判断设备陀螺仪的有效性。

// 并发异步请求 
Promise.all([hwar.createARSession(),
    setAreaGPSFun({ latitude: xxx, longitude: xxx, altitude: xxx }),  
    checkGyro()
]).then(([res1, res2, isCheckGyro]) => {
    if (isCheckGyro) {
        // 会话建立成功
    } else {
        // 该机型暂不支持
    }
}).catch((err) => {
    // 根据错误信息err.message的不同取值，处理不同事件。
});

// 设置已知地图服务区域的GPS坐标
function setAreaGPSFun(gps) {
    return new Promise((resolve, reject) => {
        hwar.setAreaGPS(gps);
        resolve(true);
    })
}

// 检测陀螺仪有效性，evt.data.gyro值为true/false
function checkGyro() {
    return new Promise((resolve, reject) => {
        hwar.addEventListener("GYRO_STATUS", (evt) => {
            resolve(evt.data.gyro);
        });
    })
}

对于并发异步请求捕获的错误信息（err.message），这里仅提供创建会话
（hwar.createARSession）的错误信息，如表1-2所示。您可以对并发请求中的其他
Promise对象抛出自定义错误信息，用于处理不同情况下的异常事件。

表 1-2 hwar.createARSession 中错误信息说明

错误信息 说明

SLAM_INIT_FAIL SLAM启动失败。

PHONE_TYPE_NOT_SURPORT 设备机型暂不支持。
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步骤3 开启AR会话状态，发送VPS请求获取定位数据。

通过回调函数（hwar.registerGetNewVpsPose）获取定位数据，如果获取失败，可通
过侦听事件“VPS_FAIL”处理。

// 设置AR状态，第一个参数设为true表示开始发送VPS请求
hwar.setARStatus(true, true, true);

// 定位成功回调函数
hwar.registerGetNewVpsPose((dictPoseData, vpsOffset) => {
    // 获取定位成功数据
});

// 定位失败事件侦听
hwar.addEventListener("VPS_FAIL", () => {
    // 处理失败逻辑
});

----结束

1.5.3 注意事项

视频流无法正常获取原因排查

如果您无法获取视频流，建议您排查以下问题：

● 检查是否存在浏览器多个标签页同时申请获取视频流的情况，建议您关闭其他标
签页。

● 检查浏览器是否支持WebRTC，如不支持，建议您更换浏览器。

● 检查应用相机权限是否打开。

● 检查移动设备后置摄像头是否能正常拍摄画面。

无法进行视觉定位原因排查

如果您无法进行视觉定位，建议您排查以下问题：

● 检查是否竖屏正向手持设备。

– 侦听事件“LANDSCAPE_BY_ROLL”检查当前屏幕是否竖屏。

– 侦听事件“ORIENTATION_NORMAL”检查屏幕正向状态。

说明

验证视觉定位效果时，您需竖屏正向手持设备扫描周边环境。

● 检查定位区域是否在地图服务范围内。

按“F12”打开DevTools，在“Network”页签中查看“vps”的状态码。如果状
态码为“400”，请在“Response”页签中查看“error_msg”内容，如显示
“access denied, out of your service zone”，则表示位置不在您的地图服务范
围。

1.6 实现 AR 导航
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1.6.1 概述
AR导航功能依赖视觉定位，提供空间位置追踪能力。

您可以依赖图像数据、相机矩阵及路径点信息进行3D导航路径渲染。

1.6.2 开发指导

开发流程

图 1-5 AR 导航启动流程

开发过程

步骤1 开启AR会话。

步骤2 选定终点位置。

通过POI智能搜索（hwar.searchPoi）选定终点坐标。
// POI智能搜索
hwar.searchPoi({
    "floor": "1F",
    "address": "xxx",
    "title": "xxx",
    "pageNum": 0,
    "pageSize": 50
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}).then((res) => {
    // POI信息列表，包含POI的UTM坐标等信息
});

步骤3 进行视觉定位。

通过设置AR会话状态（hwar.setARStatus）或者触发手动定位（hwar.requestVps）发
送定位请求，定位成功结果通过回调函数返回。
// 触发手动定位请求
hwar.requestVps();

// 设置定位成功回调函数
hwar.registerGetNewVpsPose((dictPoseData, vpsOffset) => {    
    // 可计算与上次定位的差值、与终点的距离。当有3D内容时可重置世界坐标原点重新渲染内容
});

步骤4 获取导航路径。

传入起始点与终点的UTM坐标请求导航（hwar.requestNavi），获取该段路程的路径
点。
// 请求导航路径
hwar.requestNavi("xxx", 
    [xxx, xxx, xxx], 
    [xxx, xxx, xxx], 
    1
).then((res) => {
    // 获取导航路径点信息
}).catch((err) => {
    // 获取失败
})

// 路径点结构：其中xyz是UTM坐标，渲染路径时需要转换成渲染坐标（TS语言）
export interface INaviPoint {
    linkID: number;
    x: number;
    y: number;
    z: number;
    floor: string;
    building: string;
    status: number;
}

步骤5 获取相机矩阵和视频流图像，完成空间位置追踪与渲染。

通过回调函数“hwar.registerRefreshCameraMat”获取相机矩阵和视频流图像。当步
骤3定位成功后输出相机矩阵，包含当前虚拟相机的位姿信息。视频流图像可通过
Three.js、LayaAir等WebGL渲染引擎渲染成背景画面。

说明

● 您可以根据相机矩阵、视频流图像及路径点，自定义渲染导航路径、虚拟数字内容。

● 自定义渲染导航路径时，建议您分段处理路径，及时移除失效路径点。渲染的每帧仅计算当
前相机的位置和距离相机最近的点，且仅渲染当前路段。

// 设置接收相机矩阵的回调函数
hwar.registerRefreshCameraMat((cameraMat, imgData) => {
    if (cameraMat) {
        //VPS定位成功，输出相机矩阵
        console.log(`相机矩阵：${cameraMat}`);
    }
    // 图像预览流默认宽:高=480:640，不同尺寸屏幕请自行适配
    console.log(`接收到视频流图像：${imgData}`);
});

//Three.js r144版本 相机渲染代码示例（TS语言）
//图像作为3D场景的背景,渲染器的设置如下：
this.renderer = new THREE.WebGLRenderer({ alpha: true, preserveDrawingBuffer: true, antialias: true });
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this.renderer.autoClearColor = true;
this.renderer.sortObjects = false;
this.renderer.setPixelRatio(window.devicePixelRatio);
this.renderer.setSize(window.innerWidth, window.innerHeight);
this.renderer.localClippingEnabled = true;
this.renderer.autoClear = false;
this.renderer.debug.checkShaderErrors = false;
document.body.appendChild(this.renderer.domElement);

public updateARCameraMatrix(cameraMat: THREE.Matrix4, imgData: ImageData): void {
    if (cameraMat) {
        this.camera.matrix.fromArray(cameraMat.toArray());
        this.camera.updateMatrixWorld(true);
    }
    if (imgData) {
        let buffer: Uint8Array = new Uint8Array(imgData.data.buffer);
        let tex: DataTexture = new DataTexture(buffer, 
            imgData.width, 
            imgData.height, 
            THREE.RGBAFormat
        );
        tex.needsUpdate = true;
        tex.matrixAutoUpdate = false;
        tex.magFilter = THREE.LinearFilter;
        tex.flipY = true;
        tex.encoding = THREE.sRGBEncoding;
        this.scene.background = tex;
    }
}

//LayaAir 2.12版本 相机渲染代码示例（TS语言）
//图像作为舞台的背景，将video: Laya.Sprite添加到舞台，添加3D场景，并将场景相机设置如下：
Laya.stage.addChild(this.video);
this.mainScene.mouseThrough = false;
this.mainCamera = this.mainScene.getChildByName("Main Camera") as Laya.Camera;
this.mainCamera.enableHDR = false;
this.mainCamera.clearColor = new Laya.Vector4(0, 0, 0, 255);
this.mainCamera.clearFlag = Laya.CameraClearFlags.DepthOnly;
this.mainCamera.fieldOfView = 66;
this.mainCamera.depthTextureMode = Laya.DepthTextureMode.None;
Laya.stage.addChild(this.mainScene);

public updateARCameraMatrix(cameraMat: { elements: Float32Array, isMatrix4: boolean }, imgData: 
ImageData): void {
    if (cameraMat) {
        let mat: Laya.Matrix4x4 = new Laya.Matrix4x4();
        mat.elements = cameraMat.elements;
        this.mainCamera.transform.worldMatrix = mat;
    }
    if (imgData) {
         if (this.stageHeight !== Laya.stage.height) {
             // 请自行对渲染尺寸(宽:高=480:640)做屏幕适配
             this.onResize();
         }
         if (this.videoTexture && this.videoTexture.bitmap) {
             this.videoTexture.disposeBitmap();
             this.videoTexture2D.destroy();
             this.videoTexture = null;
             this.videoTexture2D = null;
          }
          let buffer: Uint8Array = new Uint8Array(imgData.data.buffer);
          this.videoTexture2D = new Laya.Texture2D(imgData.width, imgData.height);
          this.videoTexture2D.setPixels(buffer);
          this.videoTexture = Laya.Texture.create(this.videoTexture2D, 0, 0, imgData.width, imgData.height);
          this.video.texture = this.videoTexture;
    }
}

----结束
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1.6.3 注意事项

了解坐标系

● VPS坐标系

VPS坐标系是基于UTM坐标定义的，北向Y轴正向和东向X轴正向如图1-6所示。

图 1-6 VPS 坐标系示意图

● Three.js渲染引擎坐标系

摆放虚拟物体时需要注意：Three.js的相机朝向是Z轴的反向。

图 1-7 Three.js 渲染引擎坐标系示意图

坐标系转换

SDK提供了UTM坐标与渲染引擎（如Three.js、LayaAir）坐标之间的转换方法。
// UTM坐标转成渲染坐标
let vecInit = hwar.utm2Render([utm.x, utm.y, utm.z]);

// 渲染坐标转成UTM坐标
let renderPosUtm = hwar.render2Utm([render.x, render.y, render.z]);

1.7 API 列表
WebARSDK封装类名为“hwar”，所有API均直接通过类“hwar”来调用，无需实例
化。
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说明

● 本章节所指的GPS坐标系为WGS84坐标系。

● utmCode指UTM（UNIVERSAL TRANSVERSE MERCARTOR GRID SYSTEM，通用横墨卡托
格网系统）投影带号。

● 图像流约束：宽:高=480:640，您需根据实际情况自行适配设备屏幕尺寸。

● 参数类型使用了TypeScript语言的声明规范。

1.7.1 视觉定位

接口列表

视觉定位需要使用的接口如表1-3所示。

表 1-3 视觉定位接口列表

接口 描述 参数名 参数类型 参数说明 返回值

getToken 向服务
器请求
签名。

- - - Promise<an
y>

setAKSK 验证租
户身份
信息。

requestPa
rams

{

AK: string;

SK: string;

}

访问密钥ID
（AK）和秘密
访问密钥
（SK）。

boolean
如果AK/SK
有一个是空
值就会返回
false。

setAreaG
PS

设置已
知地图
服务区
域的GPS
坐标到
AR系统
中，便
于提高
后续视
觉定位
的精
度。GPS
信息可
以从局
点配置
中获
取，也
可以通
过请求
浏览器
的位置
接口获
取。

gps {
latitude:
number;
longitude:
number;
altitude:
number;
}

GPS坐标的经纬
度及海拔高
度。

void
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接口 描述 参数名 参数类型 参数说明 返回值

searchAre
a

根据GPS
判断地
图服务
区域。

areaData {
location: {
lon: number;
lat: number;
}；
radius:
number;
}

GPS经纬度坐标
和查询半径
（单位：
米）。

Promise<an
y>
返回查询范
围内的局点
信息。

getAreaC
onfig

获取区
域配置
信息。

address string 局点名称。 Promise<an
y>

convertU
TMtoGPS

UTM转
GPS。

utm number[] utm坐标，[x,
y, z]。

number[]

isSouthH
emi

boolean 是否在南半
球。

zone number utmCode的数
值部分。定位
成功会返回
utmCode。

convertG
PStoUTM

GPS坐标
转UTM
XYZ。

gps {
longitude:
number;
latitude:
number;
altitude?:
number;
}

GPS坐标。 {
utmX:
number;
utmY:
number;
utmZ:
number;
utmCode:
string;
}
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接口 描述 参数名 参数类型 参数说明 返回值

registerGe
tNewVpsP
ose

设置定
位成功
回调函
数。

funGetNe
wPose

Function 回调函数。

需要接收两个
参数：

VPS请求接口的
返回数据和世
界坐标原点。

● dictPoseDat
a:
{ utmcode:
string;
vpsFloor:
string; pose:
{ r:
number[],
t:
number[]}
}
– dictPose

Data.pos
e.r是VPS
姿态矩阵

– dictPose
Data.pos
e.t是当
前的位置
的UTM
坐标

● vpsOffset:
Vector3

void

requestVp
s

触发手
动定位
请求。
定位结
果会通
过回调
函数返
回。

- - - void

 

接口调用示例
// 向服务器请求签名
hwar.getToken().then((res) => { 
    // 进行后续操作（无需获取具体签名值）
}).catch((err) => {
    // 获取失败
});

// 验证租户身份信息
// 认证用的AK、SK硬编码到代码中或明文存储都有很大的安全风险，建议在代码中配置加密后的AK/SK，解密后
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传入hwar.setAKSK方法中。
let result:boolean = hwar.setAKSK({
    AK: "解密后的变量",
    SK: "解密后的变量"
});

// 设置已知地图服务区域的GPS坐标
hwar.setAreaGPS({
    latitude:xxx,
    longitude:xxx,
    altitude:xxx
});

// 根据GPS判断地图服务区域
hwar.searchArea({
    "location": { "lon": xxx, "lat": xxx },
    "radius": 50
}).then((res) => {
    // 查询范围内的局点信息
});

// 获取区域配置信息
hwar.getAreaConfig("xxx").then((data) => { });

// UTM 转 GPS
let gps = hwar.convertUTMtoGPS([xxx, xxx, xxx], false, xxx);

// GPS 坐标 转 UTM XYZ
let utm = hwar.convertGPStoUTM({
    latitude: xxx,
    longitude: xxx,
    altitude: xxx
});

// 设置定位成功回调函数
hwar.registerGetNewVpsPose((dictPoseData: any, vpsOffset: Vector3) => { });

// 触发手动定位请求
hwar.requestVps();

1.7.2 空间位置追踪与渲染

接口列表

空间位置追踪与渲染需要使用到的接口如表1-4所示。

表 1-4 空间位置追踪与渲染接口列表

接口 描述 参数名 参数
类型

参数说明 返回
值

createARSes
sion

创建
AR会
话。

- - - Pro
mise
<voi
d>

setARStatus 设置
AR状
态。

isAR boole
an

是否开启AR。
● true：开启会话，开始发

送请求。

● false：关闭会话，停止发
送请求。

void
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接口 描述 参数名 参数
类型

参数说明 返回
值

apkUuidIs
Update

boole
an

是否更新会话。可选。

默认为false。
● true：重置会话，重新进

行VPS请求。

● false：不重置会话。

multiFram
e

boole
an

是否连续请求定位。可选。

默认false。
● true：连续请求定位，直

到请求成功。

● false：不连续请求定位。

registerRefre
shCameraM
at

设置
接收
相机
矩阵
的回
调函
数。

funCallBac
k

Funct
ion

回调函数。需要接收
cameraMat（相机矩阵）和
imgData（视频流图片）两
个参数。

cameraMat和imgData参数
类型：

● cameraMat：{ elements:
Float32Array; isMatrix4:
boolean }

● imgData：ImageData

void

utm2Render utm坐
标转
成渲
染坐
标。

listUtm numb
er[]

坐标数组。 Vect
or3

render2Utm 渲染
坐标
转成
UTM
坐
标。

listRender numb
er[]

坐标数组。 Vect
or3

 

接口调用示例
// 创建AR会话
hwar.createARSession().then((res) => { });

// 设置AR状态
hwar.setARStatus(true, true, true);

// 设置接收相机矩阵的回调函数（TS语言，以Three.js为例）
hwar.registerRefreshCameraMat((cameraMat: THREE.Matrix4, imgData: ImageData) => { });

// UTM坐标转成渲染坐标（TS语言，以Three.js为例）
let vecInit: THREE.Vector3 = hwar.utm2Render([xxx, xxx, xxx]);
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// 渲染坐标转成UTM坐标（TS语言，以Three.js为例）
let renderPosUtm：THREE.Vector3 = hwar.render2Utm([xxx, xxx, xxx]);

1.7.3 导航
导航需要使用到的接口如表1-5所示。

表 1-5 导航接口列表

接口 描述 参数名 参数类型 参数说明 返回值

search
Poi

POI智能搜
索。

searchD
ata

{
floor?:
string;
address?:
string;
title?:
string;
tag?:
string;
pageNum?:
number;
pageSize?:
number;
}

搜索信息。

● floor：楼
层，例如
1F，2F，
B1。

● address：局
点名称。

● title：目标
POI名称的
关键字。

● tag：目标
POI的标
签。

● pageNum：
当前页码，
从0开始。

● pageSize：
每页POI数
量。

Promise<{

count: number;

nextStartIndex:
number;

total: number;

list: PoiInfo[];

}>

返回信息列表，
list包含POI名
称、坐标、缩略
图等信息。

PoiInfo: {

arMapInfo: any;

poi: any;

poiContent:
any;

}

getPoiI
mgUrl

获取可直
接使用的
POI缩略图
的url。

url string searchPoi接口
返回的POI缩略
图的url。

Promise<any>
返回可直接使用
的POI缩略图的
url。
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接口 描述 参数名 参数类型 参数说明 返回值

request
Navi

请求导
航。

路径点的
状态分别
表示："未
知"、"直
行"、 "左
转"、"左前
方"、"左后
方"、"右
转"、"右前
方"、"右后
方"、"电
梯"、"结
束"、"扶
梯"以及"楼
梯"。

strUtm
Code

string UTM投影带
号。

例如：50N、
49N

Promise<{
listNavi:
INaviPoint[];
policyMsg:
string;
policy: number;
}>
INaviPoint: {
x: number;
y: number;
z: number;
floor: string;
building: string;
status: number;
}

listFro
m

number[] 起始点的UTM
坐标[x, y, z]。

listTo number[] 终点的UTM坐
标[x, y, z]。

strNavi
Policy

number 路线选择策
略。

● 1：最短距离

● 2：电梯优先

● 3：扶梯优先

● -2：不坐电
梯

● -3：不走扶
梯

isUseM
anyNav
iPolicy

判断是否
使用多路
径规划配
置值。

- - - boolean

onReac
hFloor

导航出电
梯后到达
指定楼
层；调用
此方法通
知启动
AR。

floor number 楼层索引，可
以从导航路径
中获取。

void

onReac
hElevat
or

导航到达
电梯。

因为到达
电梯需要
暂停AR以
降低功
耗。

- - - void
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接口 描述 参数名 参数类型 参数说明 返回值

getAng
le

获取陀螺
仪的alpha
角。

围绕z轴
（z轴垂直
于屏幕表
面，远离
屏幕的方
向为正）
旋转设备
将使alpha
角度值发
生变化。
alpha为
360°时表
示设备的
顶部正指
北极方
向。

- - - number

 

接口调用示例
// POI智能搜索
hwar.searchPoi({
    "floor": "1F",
    "address": "xxx",
    "title": "xxx",
    "pageNum": 0,
    "pageSize": 50
}).then((res) => { 
    //POI信息列表
});

// 获取可直接使用的POI缩略图的url
hwar.getPoiImgUrl("xxx").then((res) =>{ });

// 请求导航
hwar.requestNavi("xxx", [xxx, xxx, xxx], [xxx, xxx, xxx], 1).then((res) =>{ });

// 判断是否使用多路径规划配置值
hwar.isUseManyNaviPolicy();

// 导航出电梯后到达指定楼层
hwar.onReachFloor(xxx);

// 导航到达电梯
hwar.onReachElevator();

// 获取陀螺仪的alpha角
hwar.getAngle();

1.7.4 事件管理
事件管理使用到的接口如表1-6所示。
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表 1-6 事件管理接口列表

接口 描述 参数名 参数类型 参数说明 返回
值

dispatchEv
ent

事件派
发。

strId string 侦听事件id。 void

data {
[key: string]:
DataType
}

携带的数据。

addEventL
istener

事件侦
听。

strId string 侦听事件id。 void

listener Function 侦听函数，会接收
到一个参数：event:
{ data: Object }。

removeEv
entListene
r

移除侦
听事
件。

strId string 侦听事件id。 void

listener Function 侦听函数。

registerTic
k

添加定
时器。

strNam
e

string 事件名称。 void

nInterv
al

number 时间间隔（单位：
毫秒）。

funCall
back

Function 回调函数，没有接
收参数。

registerOn
ce

只执行
一次的
定时
器。

nInterv
al

number 时间间隔（单位：
毫秒）。

void

funCall
back

Function 回调函数，没有接
收参数。

unregister
Tick

删除定
时器。

strNam
e

string 要删除的定时器名
称。

void

 

接口调用示例
// 事件派发
hwar.dispatchEvent("xxx", { msg: "xxx" });

// 事件侦听
hwar.addEventListener("xxx", (evt) => { });

// 移除侦听事件
hwar.removeEventListener("xxx");

// 添加定时器
hwar.registerTick("xxx", 500, () => { });

// 只执行一次的定时器--倒计时
hwar.registerOnce(500, () => { });

// 删除定时器
hwar.unregisterTick("xxx");
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1.7.5 SDK 内部派发事件
SDK内部派发事件如表1-7所示。

表 1-7 SDK 内部派发事件列表

事件名称 描述 携带的数据 数据类
型

事件说明

GYRO_STAT
US

陀螺仪有效
性检测。

gyro boolea
n

需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.gyro表示设备
陀螺仪是否正常。

WEB_INFO 版本信息。 {
slam: string;
phone: string;
}

Object 侦听函数，会接收到一个
参数：event: { data:
Object }
● event.data.slam表示

当前AR位置追踪算法
的版本号。

● event.data.phone表
示当前设备型号。

UPDATE_CA
MERA_FOV

刷新渲染相
机FOV。只
需要相机内
参fy值，计
算透视相机
的fov值。

fy numb
er

需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.fy表示设备相
机内参fy值。

LANDSCAPE
_BY_ROLL

当前设备是
否横屏。

isLandscapeByR
oll

boolea
n

需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.isLandscapeB
yRoll表示当前设备是否
横屏。

AUGULAR_V
ELOCITY_BI
G

当设备角速
度过大时会
接收到此通
知。

str string 需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.str表示提示
信息的内容。
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事件名称 描述 携带的数据 数据类
型

事件说明

VPS_CHECK_
INFO

视觉定位时
检测信息提
示。

● 定位失
败，请
左右移
动手机
重新定
位 。

● 连续定
位失
败，请
尝试更
换场
景。

str string 需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.str表示提示
信息的内容。

ORIENTATIO
N_NORMAL

手机俯仰角
是否正常。
视觉定位时
需要竖屏正
向手持设
备。

isNormal boolea
n

需要侦听回调，回调函数
会接收到一个参数：
event: { data: Object }
event.data.isNormal表
示当前设备的俯仰角是否
正常。

VIDEO_STRE
AM_GET_ER
ROR

视频流获取
失败。

可能原因
是：

● 浏览器
不支持
WebRTC
。

● 请求打
开摄像
头权限
失败。

- - 需要侦听回调。回调函数
无event参数。

VIDEO_STRE
AM_GET_N
ONE_PIXEL

视频流为空
白像素。通
常原因是浏
览器多个标
签页同时申
请获取视频
流。

- - 需要侦听回调。回调函数
无event参数。

NO_SRTEAM 获取设备的
相机时出
错。一般是
设备没有后
置摄像头。

- - 需要侦听回调。回调函数
无event参数。
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事件名称 描述 携带的数据 数据类
型

事件说明

VPS_FAIL VPS定位失
败。可能是
定位不在地
图范围、定
位超时等原
因。

- - 需要侦听回调。回调函数
无event参数。

 

接口调用及相机 fov 设置示例
// 以事件名"UPDATE_CAMERA_FOV"为例
hwar.addEventListener("UPDATE_CAMERA_FOV", (evt) => {
    resolve(evt.data.fy);//请根据返回的fy来设置渲染相机的fov
});

// Three.js r144版本 相机fov设置代码示例（TS语言）
// 获取设备标定参数后设置相机参数
public updateFov(fy): void {
    this.nVpsFy = fy;
    let nFov: number = ThreeUtils.calculateVerticalFov(RenderConfig.RenderCameraWidth, this.nVpsFy);
    let fov: number = ThreeUtils.radianToDegree(nFov);
    this.camera.fov = fov;
}
// ThreeUtils.ts
static calculateVerticalFov(nImageHeight: number, nFocal: number) {
    return 2 * Math.atan(0.5 * nImageHeight / nFocal);
}
static radianToDegree(nRadian: number) {
    return nRadian / Math.PI * 180;
}

// LayaAir 2.12版本 相机fov设置代码示例（TS语言）
// 获取设备标定参数后设置相机参数
public updateFov(fy): void {
    this.nVpsFy = fy;
    let nFov: number = LayaUtils.calculateVerticalFov(RenderConfig.RenderCameraWidth, this.nVpsFy);
    let fov: number = LayaUtils.radianToDegree(nFov);
    this.mainCamera.fieldOfView = fov;
}
// LayaUtils.ts
static calculateVerticalFov(nImageHeight: number, nFocal: number) {
    return 2 * Math.atan(0.5 * nImageHeight / nFocal);
}
static radianToDegree(nRadian: number) {
    return nRadian / Math.PI * 180;
}

1.8 代码示例
开启AR会话功能的代码样例，具体见WebARSDK包中hwar目录下的demo.html。

说明

WebARSDK包的目录请参考图1-3。

1.9 常用调试方法
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1.9.1 调试工具

常用的调试工具包括：

● 基于Chromium内核的浏览器（例如Edge、Chrome）的开发者工具（DevTools）

● Safari浏览器

1.9.2 调试方法

准备工作

您可根据实际情况选择如下任一组设备进行调试：

● 安卓手机、数据线、Windows系统电脑。

● 苹果手机、数据线、Mac系统电脑。

调试步骤
● 选择安卓手机调试。

a. 用数据线连接手机、电脑，手机开启USB调试模式。

b. 在Chrome浏览器输入：chrome://inspect/#devices，手机打开需要调试的页
面停留片刻会出现调试的设备，如图1-8即表示连接成功，单击“inspect”进
入调试页面。

图 1-8 DevTools 成功连接安卓设备

c. 在DevTools中的Console页签查看打印输出情况，在“Network”页签查看网
络请求发送情况，在“Sources”页签对工程文件进行断点调试。

● 选择苹果手机调试。

a. 在Mac电脑中，选择“Safari 浏览器 > 偏好设置”，单击“高级”，勾选
“在菜单栏中显示‘开发’菜单”。

b. 苹果手机开启调试模式。

c. 苹果手机连接Mac电脑，打开手机Safari浏览器并运行Web页面。

d. 在Mac电脑的Safari浏览器“开发”菜单下选择已连接的苹果手机，单击手机
打开的Web页面进行调试。
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2 HTSDK 使用手册

2.1 开发概述
HTSDK是接入KooMap AR地图运行服务的端侧SDK，助力于快速构建真实和虚拟融合
世界。HTFoundation是适配HTSDK的示例代码，供用户在Unity3D中开发业务。

HTFoundation示例实现了真实世界构建、世界位姿定位和跟踪、虚实世界呈现。基于
HTFoundation示例，用户可构建虚拟世界，包括虚拟对象设计、行为设计实现和业务
逻辑开发。

图 2-1 工作原理

2.2 总体开发思路
使用HTFoundation示例开发移动端应用的工作流程如图2-2所示。
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图 2-2 工作流程

1. 创建一个新的工程目录。

使用Unity3D引擎创建基础工程，基础工程里面会有一个空的工程目录。详情见创
建Unity项目。

2. 导入ARFoundation插件包。

在Unity的Packages文件夹中找到manifest.json，输入指定命令，Unity3D将会自
动导入所添加的插件包。详情见添加插件。

3. 导入HTFoundation示例。

解压Cyberverse-HTFoundation.zip并将文件夹复制到Unity工程对应目录。详情
见导入HTFoundation示例。

4. 修改工程配置。

单击菜单“Custom Tools > Set HTFoundation Config”自动设置工程所需配置
项。详情见配置项目选项。

5. 配置AK/SK。
包含访问密钥ID（AK）和秘密访问密钥（SK）两部分，是用户在华为云的长期身
份凭证。华为云通过AK识别访问用户的身份，通过SK对请求数据进行签名验证。
详情见配置域名及密钥。

6. 打包构建。

在“HTFoundation > Samples”下找到“HTFoundationTester”，将其添加到打
包场景中进行打包构建。详情见验证结果。
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2.3 准备工作

开通关联服务

开通AR地图运行服务、AR地图数据构建服务、AR地图数据采集服务（可选）。

说明

AR地图运行服务可在KooMap管理控制台开通；AR地图数据采集服务、AR地图数据构建服务请
咨询华为云专业服务团队购买并开通。

开发技能要求
● 熟悉C#语言开发。

● 熟悉Unity3D开发。

下载 SDK

请下载Cyberverse-HTFoundation安装包和安装包完整性校验文件。

搭建开发环境
● 准备Windows，安装Unity2020或以上版本以及Visual Studio。

● 准备iOS环境，安装Xcode。

● 准备Android环境，安装Android Studio。

说明

如果您需要在华为手机上使用SDK，请咨询华为云专业服务团队。

2.4 快速开始
步骤1 创建Unity项目。

新建一个Unity Project，“Template”选择“3D”。

步骤2 导入ARFoundation包，并配置ARCore XR Plugin和ARKit XR Plugin。

1. 打开工程里自动创建的Packages文件夹目录下的manifest.json文件，在
manifest.json输入如下内容，Unity3D将会自动导入所添加的插件。
"com.unity.xr.arfoundation": "4.1.13",
"com.unity.xr.arcore": "4.1.13",
"com.unity.xr.arkit": "4.1.13",

说明

您也可以在菜单栏“Windows”里找到“Package Manager”，单击“Package
Manager”直接选择需要添加的插件。

2. 插件包导入完成后配置平台支持ARCore XR Plugin和ARKit XR Plugin。
在菜单栏“Edit > ProjectSettings > XR Plug-in Management”路径下：

– 选择 平台，勾选“ARCore”。
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– 选择iOS平台，勾选“ARKit”。

步骤3 导入HTFoundation示例。

说明

请先在“File > Build Settings > Player Settings > Player > Other Settings”中找到“Allow
'unsafe' Code”，并将其勾选。

1. 解压SDK压缩包Cyberverse-HTFoundation.zip。压缩包下载地址请参考下载
SDK。

2. 在解压的文件夹中找到CloudBuildOutput文件夹，并将该文件夹里面的Demo-
xx.zip解压到同级目录，解压后得到一个Assets文件夹。

图 2-3 解压 Demo 压缩包

3. 在解压的“Cyberverse-HTFoundation > CloudBuildOutput”下，找到
HTFoundation文件夹，并将其合并到“Cyberverse-HTFoundation >
CloudBuildOutput > Assets”的HTFoundation文件夹。

4. 将以上合并后的Assets文件夹合并到步骤1新建的Unity工程的Assets目录。

步骤4 配置Plugins文件夹里的文件。

在新建的Unity工程的“Assets > HTFoundation”找到Plugins文件夹，文件夹中包含
Android、iOS文件夹以及HT开头的SDK功能模块dll，请依照如下指引进行配置：

● 选中Android文件夹下的so文件，在Inspector窗口中，“Select platforms for
plugin”勾选“Android”，“Platform settings”中的“CPU”选择
“ARM64”。

● 选中iOS文件夹下后缀为.h、.mm和.a的文件，在Inspector窗口中，“Select
platforms for plugin”勾选“iOS”。

● 选中文件名包含Android的dll，在Inspector窗口中，“Select platforms for
plugin”勾选“Android”。

● 选中文件名包含iOS的dll，在Inspector窗口中，“Select platforms for plugin”
勾选“iOS”。

步骤5 配置项目选项。

完成以上操作后，找到菜单栏的“Custom Tools”并单击“Set HTFoundation
Config”配置项目选项，Unity将会自动进行以下设置：

● 通用设置：

– 添加Tag：Photo、Object。
– 添加Layer：

▪ Layer6：HTUI

▪ Layer17：Danger
– 不使用垂直同步。

– 默认使用竖屏。
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– 允许不安全代码。

– 关闭代码裁剪。

● iOS设置：

– iOS相机权限描述。

– iOS定位权限描述。

– IL2CPP脚本运行时环境。

● Android设置：

– 使用OpenGLES3图形API。

– 关闭多线程渲染。

– 使用最小的SDK版本29。

– 使用目标的SDK版本29。

– IL2CPP脚本运行时环境。

– 支持ARM64位处理器。

步骤6 配置域名及密钥。

工程运行需要证书校验，请将申请到的AK/SK以及固定的BASE_URL填写在新建Unity
工程的“Assets > HTFoundation > Scripts > BaseUtils > HTStringRes.cs”中的
HTStringConfig里面。

说明

● 申请AK/SK详情请参考获取AK/SK。

● 固定BASE_URL为：https://koomap.cn-north-4.myhuaweicloud.com。

// 认证用的AK、SK硬编码到代码中或明文存储都有很大的安全风险，建议在代码中配置加密后的AK、SK，在使
用的地方解密。
public class HTStringConfig
{
    public const string AK = "加密后的内容";
    public const string SK = "加密后的内容";
    public const string BASE_URL = "";
}

步骤7 验证结果。

在菜单栏单击“File > Build Settings > Add open Scenes”并添加
HTFoundationTester场景：

● Unity导出Android apk：“Platform”选择“Android”，单击“Switch
platform”。不勾选“Export Project”，单击“build”导出apk。

● Unity导出Android项目：“Platform”选择“Android”，单击“Switch
platform”。勾选“Export Project”，单击“Export”导出项目。

● Unity导出iOS项目：“Platform”选择“iOS”，单击“Switch platform >
Export”导出项目。

----结束

2.5 创建 HTFoundation 会话
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2.5.1 概述

SDK功能集成在HTFoundationOrigin预制体中，默认开启相机预览流、定位、资源加
载与调试面板功能，主要功能包含导航、白膜显隐等。其主要是由HTSysEntrance和
Canvas构成：

● HTSysEntrance：负责提供SDK功能并维护生命周期。

● Canvas：负责提供示例界面UI。

在新建的Unity工程“Assets > HTFoundation > Scenes”路径下包含一个基础场景
HTFoundationScene，它是一个只包含HTFoundationOrigin预制体的场景。您可以直
接在这个场景进行二次开发。

2.5.2 开发指导

开发流程

创建和开发流程如图2-4所示。

图 2-4 流程图
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开发过程

步骤1 配置AK/SK信息。

在新建的Unity工程“Assets > HTFoundation > Scripts > BaseUtils”中找到
HTStringRes.cs，并在HTStringRes.cs配置AK/SK信息以及输入固定的BASE_URL。

说明

● 申请AK/SK详情请参考获取AK/SK。

● 固定BASE_URL为：https://koomap.cn-north-4.myhuaweicloud.com。

// 认证用的AK、SK硬编码到代码中或明文存储都有很大的安全风险，建议在代码中配置加密后的AK、SK，在使
用的地方解密。
public class HTStringConfig
{
    public const string AK = "加密后的内容";
    public const string SK = "加密后的内容";
    public const string BASE_URL = "";
}

步骤2 创建HTFoundationOrigin。

单击Unity菜单栏“Custom Tools > Create”中的“HTFoundationOrigin”，Unity会
自动创建Prefab。

步骤3 配置功能。

展开“HTFoundationOrigin”目录并单击“HTSysEntrance”，根据实际情况配置需
要的功能。其中默认配置HTRes（资源加载）、HTNavi（导航功能）、HTGvps（定位
功能）。

配置完成后，启动当前场景，自动获取状态信息，开启视觉定位和加载数字资源：

● 视觉定位：自动定位和手动定位。

– 自动定位：

系统默认开启自动定位功能。在定位丢失状态下，每隔1秒刷新一次定位，直
到成功。定位成功状态下，每隔15秒刷新一次定位。您可根据实际需求设置
刷新时间。
// 第一个参数是定位丢失时的定位刷新时间，第二个参数是定位成功后的定位刷新时间
mHtSystem.Start(HTSystemManager.FastLocinterval, 
HTSystemManager.NormalLocaIntervalNonVpp);

– 手动定位：

i. 创建HTGvpsRequestOpExt实例。
protected HTGvpsRequestOpExt mGvpsOp = new HTGvpsRequestOpExt();

ii. 调用HTGvpsRequestOpExt的RequestGvpsLocaiton方法进行一次手动定
位请求。
mGvpsOp.RequestGvpsLocaiton(HTSystemManager.GetHTSystem(), 
HTRequestPriority.ForceRequest, HTVpsRequestType.ManualClick, OnLocation);

iii. 通过HTGvpsRequestOpExt类的Addobserver方法将定位添加到SDK系统
的监听池中。

定位结果将通过HTGvpsRequestOpExt类中的OnLocation方法返回。
mGvpsOp.AddObserver(HTSystemManager.GetHTSystem());

说明

您可在Unity新建工程的“Assets > HTFoundation > Samples >
HTFoundationTester > Scripts”中找到HTManualReq.cs并查看参考实例。
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● 加载数字资源：

HTResManager为场景中挂载的类，控制着HTResSession类的创建以及资源加载
流程的生命周期。

HTResSession构造了资源管理类HTResPumper和资源渲染类HTResRender，主要
对外提供了dll的生命周期，相对于Unity生命周期的映射及内容回调。

对资源模块的信息配置及功能调整，都可以在这里进行。

HTResCtro主要进行资源材质的二次赋值，能很好的修复PC端加载资源出现材质
丢失的问题，主要方法为FixShader(GameObject obj)。
核心方法代码如下：
public void Create(bool isRequestDigital = true, bool isUseSecondaryOffset = true)
        {
            Debug.Log("HTResSession Create HTPerformance +");
            if (mHTBehaviourFactory == null)
            {
                mHTBehaviourFactory = new HTBehaviourFactory();
            }
            bool isResLstOnline = true;
            bool isResLstDump = false;
            bool isResCacherDe = false;
            mResRender = new HTResRender(mOwner, mHTBehaviourFactory);
            mResPumper = new HTResPumper(
                HTSystemManager.GetHTSystem().GetAppConfig(),
                HTSystemManager.GetHTSystem().GetAppEnv(),
                HTSystemManager.GetHTSystem().GetWorldControl(),
                HTSystemManager.GetHTSystem().GetSniffer(),
                HTSystemManager.GetHTSystem().GetJniAttach(),
                mResRender,
                mSysSession.mHostUrl,
                Application.temporaryCachePath,
                mSysSession.mPlaformType,
                isResLstOnline,
                isResLstDump,
                isResCacherDe,
                isRequestDigital,
                isUseSecondaryOffset 
                );
            mResRender.SetRealWordMatPath(HTStringMat.WORLD_REAL);
            ((IHTActor)(mResPumper)).Create("resPumper");
            Debug.Log("HTResSession Create HTPerformance -");
        }

相关参数解释如下：

● HTBehaviourFactory：资源的行为脚本厂类，SDK提供了一套通用的行为供用户
使用，用户也可以创建自己的行为厂类，需继承IHTBehaviourFactory接口类。

● isResLstOnline：是否加载在线资源（加载离线资源需先缓存Dump，并且把缓存
的TXT放在Application.temporaryCachePath下的ResLstCache文件夹内）。

● isResLstDump：是否缓存资源列表的TXT。

● GetAppConfig：获取应用鉴权参数。

● GetAppEnv：获取App环境参数。

● GetWorldControl：获取资源世界的参数，例如是否在服务区、获取坐标偏移量等
信息。

● GetSniffer：获取定位及传感器信息。

● GetJniAttach：子线程向Android客户端发送信息时需要使用。

● mResRender：HTResRender.dll的实例。

● mHostUrl：存储云端数字资源的域名。
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● mPlaformType：当前移动设备的平台（Android或iOS）。

● isRequestDigital：是否需要加载数字资源。

● isUseSecondaryOffset：是否开启二次偏移。

说明

资源模块运行时，判断当前位置是否在服务区，可通过如下接口进行判断：

int serviceid = HTSystemManager.GetHTSystem().GetWorldControl().GetServiceCode();

其中，返回的serviceid参数解释如下：

● serviceid > 0：在服务区

● serviceid = 0：未知

● serviceid < 0：不在服务区

----结束

2.5.3 注意事项

● 模块之间启动销毁存在相关依赖需要按照一定顺序执行，HTSysEntrance需要最先
执行。脚本执行顺序可见“Assets > HTFoundation > Scripts”中的
SessionsManager.cs文件。

● 由于SDK的虚拟世界比较庞大，导致距离坐标世界原点较远的虚拟资源坐标值很
大，可能会引起一些渲染上的异常（例如模型闪烁，抖动等），因此SDK会将资
源进行二次偏移以减小资源的坐标值。

说明

如果您需要获取数字资源在虚拟世界中根节点的偏移量，请参考如下方法：

HTVector2f vector2f = 
HTSystemManager.GetHTSystem().GetWorldControl().GetSecondaryOffset();//（x轴和z轴，y轴无
偏移）

2.6 AR 导航

2.6.1 概述

AR导航功能依赖视觉定位，进行空间位置跟踪。它将会根据当前位置信息及终点信息
获取路径点信息，然后进行3D虚拟世界渲染操作。

其包含的功能主要有路线规划及导航指示：

● 路线规划：根据目的地和当前位置，自动规划合适的路线。

● 导航指示：引导用户沿着设定的路线前进，并在需要时提供转弯提示等导航信
息。

2.6.2 开发指导

开发流程

开发流程请参考图2-5。
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图 2-5 开发流程图

开发过程

步骤1 搜索POI。
// 创建获取POI的异步任务栈
var mPOICloud = new HTPOICloud(); 

// 将生命周期绑定到unity的生命周期
mPOICloud.Create("NAVIPOI"); // 参数设置的是线程名
mPOICloud.Start();
mPOICloud.Stop();
mPOICloud.Destroy();

// 设置系统的基本参数
mPOICloud.SetParams(HTSystemManager.GetHTSystem().GetAppConfig(), 
HTSystemManager.GetHTSystem().GetAppEnv(), hostUrl);

// 设置成功失败的回调监听
mPOICloud.AddListListener(SelecteDestination);
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mPOICloud.AddErrorListener(OnPoiError);

// 根据gps获取附近的POI
double lon = HTSystemManager.GetHTSystem().GetSniffer().GetGpsLocation().mLongitude;
double lat = HTSystemManager.GetHTSystem().GetSniffer().GetGpsLocation().mLatitude;
mPOICloud.GetDataList(lon, lat);

步骤2 选定终点。

HTNaviManager会自动管理HTNaviSession中导航功能的生命周期，被默认挂载在预
制体当中，使用时可以直接通过HTNaviSession的mNavi来调用各种方法。
// 导航终点坐标是虚拟世界坐标，可以直接带入POI上返回的坐标
mNaviSession.mNavi.SetDestination(447763.6348, 4418530.1394, 37.979218);

步骤3 发起导航。
mNaviSession.mNavi.StartNavi();

步骤4 回调监听。
// 导航实时信息监听
mNaviSession.mNaviInfoListener = OnNaviInfoStatus;
// 导航失败信息监听
mNaviSession.mNaviErrorListener = OnNaviError;
// 进入电梯信息监听
mNaviSession.mNaviElevatorListener = OnNaviElevator;
// 方向引导信息监听
mNaviSession.mNaviDirectionListener = OnNaviDirection;
// 偏移量信息监听
mNaviSession.mNaviYawListener = ShowYaw;

说明

您可在Unity新建工程的“Assets > HTFoundation > Samples > HTFoundationTester >
Scripts”中找到HTNaviCtro.cs并查看参考实例。

----结束

2.6.3 注意事项

创建导航
// HTNavigationProvider是为导航模块提供参数与配置的类，通过对这个类的参数调整，可以对导航功能进行详
细配置
mNaviProvider = new HTNavigationProvider(HTSystemManager.GetHTSystem().GetARPlugin(), 
HTSystemManager.GetHTSystem().GetWorldControl());

// HTNavigationRender负责将路径节点渲染成导航路径
mNaviRender = new HTNavigationRender();

// HTNaviManage是sdk中导航功能的管理类，回调都是从这个类中接收的
mNavi = new HTNaviManage();
mNavi.Create(HTSystemManager.GetHTSystem().GetAppConfig(),HTSystemManager.GetHTSystem().GetApp
Env(),hostUrl,mNaviProvider,mNaviRender);

说明

您可在Unity新建工程的“Assets > HTFoundation > Scripts > HTPlatform”中找到
HTNaviSession.cs并查看参考实例。

HTNaviManager

导航的生命周期需要与Unity绑定，您可以参考“Assets > HTFoundation > Scripts >
SessionsManager”中的HTNaviManager.cs文件。这里主要说明Update、导航回调和
渲染的注意事项。
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● Update：
// Update负责实时导航功能的实现，isTracking表示的是当前用户的定位状态
mNavi.Update(isTracking);

说明

您可在Unity新建工程的“Assets > HTFoundation > Scripts > HTPlatform”中找到
HTNaviSession.cs并查看参考实例。

● 导航回调：
// 这是一个必要监听
mNavi.AddNaviErrorListener(NaviErrorListener);
// 这是导航启动失败的错误，需重新开始导航
HTNaviErrorCode.LOAD_RES
HTNaviErrorCode.GVPS_DISABLE
HTNaviErrorCode.NET_DISABLE
// 这是请求导航路径失败，会中断导航可通过ContinueNavi继续
HTNaviErrorCode.NET_ERROR
// 这是提示性错误不会中断导航
HTNaviErrorCode.NAVIGATING
HTNaviErrorCode.LOST_TRACK

// 这是一个必要监听
// 进入电梯会中断导航，需要外部的重定位来继续导航
mNavi.AddNaviElevatorListener(NaviElevatorListener);
// 这个方法通知导航模块已经出电梯了
mNaviSession.mNavi.ContinueNavi();
// 这个方法通知导航模块已重新gvps定位
mNaviSession.mNavi.IsRefreshGvps();

// 这是一个可选监听
// 如果启动了导航的偏移量监听，在用户偏航的时候会根据返回的bool中断导航。中断后，需要调用
RequestNaviInfo，获取最新的导航路线继续导航
mNavi.AddNaviYawListener(NaviYawListener);
mNaviSession.mNaviYawListener = ShowYaw;
public bool ShowYaw(float yaw)
{
    ReplaceBtnListener(mNaviInfoDialogPanel.GetComponentInChildren<Button>(), () =>
    {
        mNaviSession.mNavi.RequestNaviInfo();
        mNaviInfoDialogPanel.SetActive(false);
    });
    mNaviInfoDialogPanel.GetComponentInChildren<Text>().text = "偏航" + yaw + "m,为您重新规划路线
";
    mNaviInfoDialogPanel.SetActive(true);
    return true;
}

// 这是一个可选监听
// 如果启动了导航路径监听，在获取导航路径的时候会中断导航，等待调用ResetNaviRoute选择导航路径
继续导航
mNavi.AddNaviPathListener(NaviPathListener);
mNaviSession.mNavi.ResetNaviRoute(naviContent.path[0]);

说明

您可在Unity新建工程的“Assets > HTFoundation > Scripts > SessionsManager”中找到
HTNaviManager.cs并查看参考实例。

● 渲染：

由于导航默认会根据白膜调整导航高度，所以系统会返回白膜渲染完的通知。如
果不需要等待通知可以直接提前调用IsRenderReady。
mNavi.IsRenderReady();

说明

您可在Unity新建工程的“Assets > HTFoundation > Samples > HTFoundationTester >
Scripts”中找到HTNaviCtro.cs并查看参考实例。
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HTNavigationProvider
在HTNavigationProvider中可以配置很多导航模块参数，如果想进行更多的参数调
整，可以通过调用IHTNavigationProvider接口或者继承HTNavigationProvider来实
现。

public class HTNavigationProviderExt : HTNavigationProvider
{
  ...
}
mNaviProvider = new HTNavigationProviderExt(HTSystemManager.GetHTSystem().GetARPlugin(), 
HTSystemManager.GetHTSystem().GetWorldControl());

说明

您可在Unity新建工程的“Assets > HTFoundation > Scripts > HTPlatform”中找到
HTNavigationProviderExt.cs并查看参考实例。

HTNavigationRender
HTNavigationRender主要负责对导航路径的渲染，通过继承和实现接口实现高度自定
义。

说明

您可在Unity新建工程的“Assets > HTFoundation > Scripts > HTPlatform”中找到
HTNavigationRenderExt.cs并查看参考实例。

2.7 代码示例
完整的示例代码在SDK压缩包Cyberverse-HTFoundation.zip的Demo.zip中。

您可在创建完成后的Unity项目中找到对应的示例代码。

2.8 常用调试方法

2.8.1 调试工具
调试工具包括：

● 安卓手机

● Windows系统电脑

● USB数据线

2.8.2 cfg.ini 调试方法

基本原理

您可以通过创建和修改应用目录下的cfg.ini文件调试信息配置，调试信息在配置文件中
以键值对的形式存在。ini文件的配置目录如下：

● Unity：C:\...\AppData\LocalLow\{company name} \{product name} \ini
● Android：/sdcard/android/data/{pakagename}/files/ini
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● iOS：手机连接Mac操作系统电脑，连接后在电脑的“iPhone > 文件”里面找到
导入的应用名，应用名下有ini文件夹，请把配置了如下命令的ini文件拖入ini文件
夹即可。

配置样例：
loglevel:UPDATE
debugger_ctrl_switch:ON
fixed_location_switch:ON
longitude:11.111111
latitude:22.2222222

设置调试选项

此功能必须在Unity的工程配置宏定义UNITY_HTDEBUG后方可使用，设置步骤如下：

步骤1 打开“Unity > Edit”，并找到“Project Settings”。

步骤2 在“Project Settings”中找到“Player”并单击打开。

步骤3 找到“Other Settings”，往下拉，可见“Script Compilation”下方的“Scripting
Define Symbols”。

步骤4 在“Scripting Define Symbols”输入框中输入“UNITY_HTDEBUG”。

步骤5 单击“Apply”，设置成功。

----结束

调试选项
● loglevel：UPDATE|INFO|WARNING|ASSERT|EXCEPTION|ERROR|NONE

日志级别左边包含右边的日志信息，即UPDATE级别会打印所有日志信息，使用
该字段会打印HTDebug的日志，并写日志到此文件的上一级文件目录。NONE表
示不保存log。

● debugger_ctrl_switch：ON|OFF
是否在日志中显示调试面板，只对HTAppUIType中mNativeAppIds包含的应用包
名有效。

● fixed_location_switch：ON|OFF
是否使用自定义的固定位置。

● longitude
经度，填写固定位置经纬的值，只在“fixed_location_switch”为“ON”时有
效。

● latitude
纬度，填写固定位置纬度的值，只在“fixed_location_switch”为“ON”时有
效。
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